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Teacher's Manual
TECH WORLD-1

CHAPTER 1 : INTRODUCTION COMPUTER

A. 1. c 2. a 3. b B. 1. man-made 2. natural 3. electricity  
4. time C. 1. F 2. T 3. T 4. F D. 1. Things that are made by 
nature are called natural things. 2. Things, that make our 
works easy and fast are called machines 3. (i) Machines need 
our instructions to do a work. (ii) Most of the machines need 
fuel to run. 4. Computer is used at home, school, shop, 
airport, hotel, office, bank, railway station, police station, etc. 
E. COMPUTER 

CHAPTER 2 :  COMPUTER– A SMART MACHINE 

A. 1. b 2. a 3. c B. 1. school 2. music 3. sums C. 1. F 2. T  
3. F D. 1. To study and play games, To deposit and withdraw 
money. 2. Banks, School, Hotel, Home 3. It remember many 
things, It never get tired, It works very fast.  

CHAPTER 3 : PARTS OF A COMPUTER 

A. 1. b 2. c 3. b B. 1. VDU 2. keyboard 3. commands C. 1. 
T 2. F 3. T D. 1. CPU is the brain of the computer and it 
stands for Centeral Processing Unit. 2. Key board is used for 
typing, keyboard is used to give commands to the computer 
3. Mouse helps to draw pictures, It helps to play games.  
E. 1. c 2. b 3. d 4. a. 
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CHAPTER 4 : THE KEYBOARD

A. 1. (a) 2. (c) 3. (b) B. 1. numbers 2. spacebar key 3. two 
C. 1. F 2. T 3. T D. 1. The alphabet keys are used to type 
words and sentences. 2. The spacebar key is used to give 
space between two words and the enter key is used to move 
cursor to the next line. 3. Cursor is a small blinking line on 
the monitor which tells the position of the typed text. 

CHAPTER 5 : LEARN TO USE A MOUSE

A. 1. b 2. a 3. c B. 1. draw 2. single click 3. computer  
4. mouse pad C. 1. F 2. F 3. T 4. T D. 1.  Dragging the mouse 
means to move an object while holding the left button 
pressed. 2. Pressing and releasing the left mouse button 
twice in a quick time is called a double click. 3. A mouse 
has three buttons; (i) left button (ii) centre button or scroll 
wheel (iii) right button 4. Put the index finger on the left 
mouse button. E. 1. Ring finger 2. Thumb 3. Middle finger 
4. Index finger.  

CHAPTER 6 : MORE PARTS OF COMPUTER

A. 1. Joy stick 2. Hard disk 3. Printer 4. Scanner 5. UPS  
B. Do yourself C. 1. T 2. F 3. T 4. F 5. T D. 1. Compact Disk 
2. Uninterrupted Power Supply. E. 1. CPU, Keyboard, Mouse, 
Moiter, Printer, Scanner, Etc. are some parts of computer.  
2. Joystick is used to play games. 3. Printer is used to take 
printout on paper. 4. Pen drive is used to store files. 5. UPS 
is a part of computer that keeps the computer ON for some 
time even after the electricity goes off.
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CHAPTER 7 : STARTING OF COMPUTER

A. 1. b 2. a 3. a B. 1. F 2. F 3. T 4. T C. 1. Damaged 2. Desktop 
3. Start 4. Icons 5. Other buttons D. 1. Do yourself. E. 1. (i) 
Switch On the power supply. (ii) Switch ON the UPS system. 
(iii) Switch ON the power button of CPU. (iv) Finally switch 
ON the monitor. 2. (i) Click on the START button. (ii) From 
the list, select Turn off computer. (iii) Turn off the button on 
the dialog box. (iv) Switch off the computer when you see 
the message on monitor screen. 3. UPS keeps the computer 
ON for some time even after the electricity goes off. 

CHAPTER 8 : FUN WITH PAINT

A. 1. b 2. a 3. b  B. 1. Microsoft 2. Shapes 3. Eraser C. 1. 
T 2. F 3. T D. 1. Tool group, shapes group, colours group  
2. Ribbion → It contain tabs, group and commands. Tabs → 
It contains tools arranged in different groups. 3. 1. Click on 
the Home tab. 2. Click on the Oval in the shapes group. 3. 
Click on the drawing area and drag the mouse to another 
place.  As you drag, a circle is drawn. E. 1. d 2. c 3. b 4. a 

CHAPTER 9 : MANNERS IN THE COMPUTER LAB

A. 1. c 2. b 3. c B. 1. moniter 2. computer 3. keyboard C. 1. F 
2. F 3. T 4. T D. 1. (i) Do not push the computer table (ii) Do 
not eat on the computer table (iii) Always keep the  mouse 
on the mouse pad. 2. We  must act properly in the computer 
lab and follow good manners. 3. Sitting too close to monitor 
will harm your eyes. 4. We should keep the mouse on the 
mouse pad. E. 1. 73 2. 73.
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ASSESMENT TEST PAPER-1

A. 1. (b) 2. (b) 3. (a) 4. (c) 5. (c) 6. (b) 7. (a) B. 1. Spacebar 
2. VDU 3. school 4. easy 5. music 6. commands 7. numbers 
C. 1. F 2. F 3. T 4. T. 5. T 6. F 7. F D. 1. The spacebar key is 
used to give space between two words and the enter key is 
used to move cursor to the next line. 2. CPU is the brain of 
the computer and it stands for Central Processing Unit. 3. A 
computer is a machine which makes our work easy and it 
works on electricity. 4. It remember many things, It never get 
tired, It works very fast.

ASSESMENT TEST PAPER-II

A. 1. c 2. b 3. b 4. b 5. b 6. a 7. a 8. c B. 1. Shapes 2. 
computer 3. keyboard 4. mouse pad 5. UPS 6. monitor 7. 
icons 8. eraser C. 1. F 2. F 3. F 4. T 5. F 6. T 7. T 8. T D. 1. 
Dragging the mouse means to move an object while holding 
the left button pressed. 2. (i) Click on the Home tab (ii) Click 
on the oval in the Shapes group 3. Click on the drawing area 
and drag the mouse to another place. As you drag, a circle 
is drawn. 3. We should keep the mouse on the mouse pad. 
4. Pressing and releasing the left mouse button twice in a 
quick time is called a double-click. 5. Put the index finger 
on the left mouse button. 6. UPS is a part of computer that 
keeps the computer ON for some time When the electricity 
goes off. 7. Switch ON the main power supply button  
Switch ON the UPS button  Switch ON the CPU button 

 Switch ON the monitor button. 8. Paint button contains 
different options to work. Ribbon contains tools arranged in 
different groups. 

  
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TECH WORLD-2

CHAPTER 1 : COMPUTER- AN ELECTRONIC MACHINE

A. 1. a 2. c 3. c B. 1. keys 2. CPU 3. printer 4. scanner C. 1. 
F 2. T 3. T 4. F D. 1. The mouse is used to point and select 
an object 2. The four main part of a computer: mouse, CPU, 
keyboard and moniter. 3. (i) Play games (ii) Watch movies 
4. A human being can think but a computer cannot think.    

CHAPTER 2 : USES OF COMPUTER 

A. 1. b 2. b 3. a 4. b B. 1. cars 2. weather 3. time table  
4. diagnosing C. 1. F 2. T 3. T 4. F D. 1. Computer is used 
at school to keep records and help teacher to teach. 2. To 
purchase item from home with the help of computer is known 
as online shopping. 3. (i) It helps doctors in doing operation. 
(ii) It helps in diagonse various diseases. 4. Computer are 
used at (i) Schools (ii) Hospitals (iii) Banks (iv) Offices.  

CHAPTER 3 : OPERATING SYSTEM                                  

A. 1. c 2. b 3. a 4. a B. 1. windows 2. desktop 3. click  
4. taskbar C. 1. F 2. F 3. F 4. F  D. An operating system 
is a software that helps the user to work with computer.  
2. Single user operating system is generally used at homes, 
while multi-user operating system is used in offices and big 
organizations like hospitals and railway stations. 3. Desktop 
is the first screen that appears on monitor after some time to 
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start the computer. 4. Yes. E. 1. Single-user operating system 
allows only one user to work on it at a time. 2. (i) Move the 
mouse pointer to an empty space on the taskbar. (ii) Click 
and hold the mouse button. (iii) Drag the mouse pointer 
to the right of the computer screen. (iv) Release the mouse 
button. 3. A file contains data, program, etc., while folder is 
used to store a group of files. 4. Left pane– It shows a list of 
recently opened programs. Right Pane– It provides access 
to commonly used folders, files, settings and features. 

CHAPTER 4 : OPERATING THE COMPUTER

A. 1. c 2. b 3. b B. 1. icons 2. CPU 3. desktop C. 1. F 2. F  
3. F D. 1. Closing the computer means to shut down on turn 
off the computer. 2. Desktop is the first screen that appears 
on starting a computer. 3. This means that it is not active, 
but you can read the items in the wordpad window. 4. Icons 
are the small pictures on the desktop. 

CHAPTER 5 : KEYBOARD AND ITS FUNCTIONS                                  

A. 1. b 2. a 3. b 4. b B. 1. Caps Lock 2. Return 3. Left Arrow 
4. Delete C. 1. F 2. T 3. T 4. F D. 1. Caps Lock key is used to 
type in capital letter when on. 2. (i) Spacebar key (ii) Enter 
key (iii) Caps Lock key (iv) Arrow key (v) Backspace key (vi) 
Delete key. 3. The number keys are used to type numbers. 
They are marked with the digit 0 to 9.  

CHAPTER 6 : MORE ABOUT MOUSE 

A. 1. c 2. a 3. a 4. b B. 1. Douglas Englebart 2. mouse pointer 
3. Double click 4. scroll C. 1. F 2. F 3. F 4. T. D. 1. The right 
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click is used to display a list of commands on the monitor. 
2. Drag and drop is used to move an object on the screen 
from one place to another. 3. The slant arrow on the screen 
is called a mouse pointer.  

CHAPTER 7 : MORE ON PAINT 

A. 1. a 2. a 3. a B. 1. Fill with colour 2. Curve 3. drawing 
area 4. title bar C. 1. F 2. T 3. F 4. F D. 1. Colour button 
shows the background colour. 2. (i) Paint Button: It contains 
different options to work in Paint. (ii) Group: It contains a 
set of related commands. 3. Eraser tool is used for erasing 
any part of a picture. 4. Curve tool is used for drawing 
curved lines. E. c a b c

CHAPTER 8 : INTRODUCTION TO TUX PAINT

A. 1. c 2. a 3. b B. 1. Eraser tool 2. Tool bar 4. Tux Paint 
C. 1. F 2. F 3. T D. 1. Parts of the Tux Paint screen are, (i) 
Toolbar (ii) Selector (iii) Colour box (iv) Help area (v) Drawing 
canvas. 2. Tux Paint is used to make beautiful drawing just 
like paint. 3. To save your drawing, click on the Save option 
from the toolbar.  

CHAPTER 9 : INTRODUCTION TO WORDPAD 

A. 1. a 2. c 3. c B. 1. Quick access toolbar 2. Text area  
3. cursor C. 1. F 2. F 3. T 4. F D. 1. Quick access toolbar helps 
to do common tasks with just one click. 2. Cursor is a small 
blinking line on the text area. It tells the position of the 
typed text. 3. Wordpad is a program of the accesories menu 
and used for typing text. E. 1. KEYBOARD 2. BACKSPACE  
3. NUMERIC 4. ENTER 
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CHAPTER 10 : LOOKING AFTER YOUR COMPUTER 

A. 1. c 2. a 3. b 4. a B. 1. Shutdown 2. CD, DVD 3. dusty, 
hot, humid, 4. good C. 1. T 2. F 3. T 4. T D. 1. We should use 
the origneal software. 2. An anti-virus program protects the 
computer from harmful programs. 3. We should clean the CD 
or DVD with a soft cloth. 4. We should protect the monitor 
from direct sunlight, humidity and high temperature. E. 1. (i) 
Don’t enter the computer room with shoes. (ii) Don’t let the 
computer share an electric socket with another large machine. 
(iii) Don’t pull the wires or knoct hard against anypart of the 
computer. (iv) Don’t use the pirated software. (v) Don’t turn 
the computer ON and OFF too many times through the day. 
2. ⇒ Protect the keyboard from dust and grim. ⇒ Clean it 
regulary with a soft and dry cloth. ⇒ Don’t hit the keys 
hard. ⇒ Don’t bring food or drink near the keyboard. 3. ⇒ 
Protect the monitor from direct sunlight, humidity and high 
temperature. ⇒ Keep it free of dust and clean it with a soft 
and dry cloth. F. 1. ⇒ Protect the keyboard from dust and 
grim. ⇒ Clean it regulary with a soft and dry cloth. ⇒ Don’t 
hit the keys hard. ⇒ Don’t bring food or drink near the 
keyboard. 2. (i) We should keep the mouse on the mouse 
pad. (ii) We shouldn’t touch the mouse with dirty and sticky 
hands. (iii) We should click the mouse buttons gently.

ASSESSMENT TEST PAPER-1 

A. 1. c 2. a 3. c 4. a 5. a 6. b 7. b 8. b B. 1. Caps lock  
2. CPU 3. time table 4. scanner 5. CPU 6. Weather 7. Taskbar 
C. 1. T 2. F 3. F 4. F 5. F 6. T 7. F 8. F. D. 1. The number keys 
are used to type number. They are marked with the digit 0 
to 9. 2. The first display screen that appears on starting a 
computer is called Desktop. 3. To purchase item from home 
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with the help of computer is known as online shopping.  
4. A human being can think but a computer cannot think. 
5. Keyboard, mouse, CPU and keyboard. 6. School, Hospital, 
Railway station and airport. 7. Single user operating system 
is used in homes, while multi-user operating system is used 
in offices and big organizations. 8. Caps lock key is used to 
type capital letters, when it is ON.

ASSESSMENT TEST PAPER-II

A. 1. c 2. b 3. a 4. c 5. b 6. a 7. c 8. c B. 1. cursor 2. Text 
area 3. curve 4. Title bar 5. double click 6. drawing area 7. 
toolbar 8. cursor C. 1. F. 2. F. 3. F 4. T 5. F 6. f 7. F 8. F D. 1. 
(i) Paint Button: It contains different option to work in paint 
(ii) Group: It contains a set of related commands. 2. The 
slant arrow on the screen is called the mouse pointer. 3. To 
save our drawing, click on Save option from the tool bar. 4. 
The right-click is used to display a list of commands on the 
monitor. 5. We should use origenal software. 7. Cursor is a 
small blinking line presented on the monitor. 8. An anti-virus 
program protects computer from harmful programs.  

  
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TECH WORLD-3
CHAPTER  1 : INTRODUCTION TO COMPUTER

A. 1. b 2. a 3. c 4. a 5. c B. 1. T 2. F 3. T 4. F C. 1. Software 
2 data 3. Vasual Display Unit 4. Start D. 1. Preparing mango 
shake. 2. We can see and touch hardware while software 
cannot be seen or touch. 3. Input devices : Keyboard and 



Tech World (1-5) 11

monitor. Output devices : Monitor and printer. 4. Switch ON 
the main power supply  Switch ON the UPS button  
Switch ON the CPU button  Switch ON the monitor.  E. 1. • 
Entering data into the computer is called Input. • Performing 
calculations or comparing data is called processing. • Output 
is the result given by the computer after processing. 2. ALU 
: It performs all the arithmatic and logical calculations. CU 
: Control Unit or CU controls the movement of information 
between the registers, ALU and other parts of computer. 
Registers : All data to be processed and stored in registers. 
3. Mouse is an input as well as the pointing device that is 
used to point and select the things on the computer monitor. 
It is connect with CPU by a wire. 4. Click on Start button
click on the ‘Turn of’ option in the menu Switch off the 
UPS, and main power supply button.

CHAPTER  2 : HARDWARE AND SOFTWARE

A. 1. a 2. b 3. a 4. b 5. c B. 1. storage devices 2. output 
devices 3. computer 4. software 5. operating system C. 1. F 
2. F. 3. T. 4. T. 5. T. D. 1. Computer hardware refers to all the 
electronic and mechanical parts of a computer system.  2. 
(i) Motherboard (ii) RAM (iii) Hard disk 3. The devices Which 
are used to entering data into the comptuer, are called input 
device such as keyboard, mouse, scanner, etc. 4. The device 
that is used to process data is called processing device 
is a processing device. 5. Software is a set of programs 
that tells a computer what to do there are two types of  
software. 
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CHAPTER 3 : MORE ABOUT KEYBOARD 

A. 1. b 2. b 3. b 4. a B. 1. Caps lock 2. Special 3. End 4. 
Standard C. 1. F 2. F 3. F 4. T D. 1. Used to given space 
between two words and sentences. 2. Used to bring the 
cursor in next line and send commands into the computer’s 
memory. 3. Caps lock key is used to type letters in capital. 
4. This key is used to type special symbol and punctuation 
marks and type the capital letters. 5. This key used to 
erase anything typed on the left side of the cursar. 6. This 
key is used to move cursar to the beginning of a line. E. 
1. The different types of the keys on the keyboard are: • 
Alphbet keys • Arrow keys • Number keys • Special keys • 
Navigation keys • Function keys. 2. Function keys are used 
to perform special functions. they are present on the top of 
the keyboard. 3. Enter Key is used to move the cursor on 
the begining of the next line. 4. Take care of the following 
things while using the keyboard. • Do not pull or push the 
keyboard too hard. it may damage the wire connected to 
the keyboard. • Do not keep anything on the keyboard such 
as books and CDs. 

CHAPTER4 : STARTING WITH WINDOWS 10

A. 1. b 2. c 3. a 4. c B. 1. Operating system 2. Taskbar 3. 
Desktop 4. Icon C. 1. F 2. T 3. F 4. T 5. T D. 1. A computer 
cannot work with out an operating system, so we need it 
for operating the computer. 2. Windows 10 is the latest 
version of windows operating system. 3. Enter the login.live.
com  locate and select Sign up now  The sign up 
form will appear. Follow the instuctions displayed and enter 
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the required information  Select the Mirosoft Services 
Agreement Policy, then enter Create Account. 5. Click the 
Start button  Choose Power and click Shut down button.  

CHAPTER5 : INTRODUCTION TO WORDPAD

A. 1. c 2. b 3. a 4. b 5. b B. 1. text 2. Underline 3. Formatting 
4. Font size 5. Format C. 1. T 2. F 3. F 4. T 5. F D. 1. Wordpad 
is a word process of Ms Windows. It helps us to type and 
work with words and letters to create a text document. 2. To 
apply bullets in a document, Place the cursor at the position 
when we want to create bullet  Open Format menu  
click on Bullet style option. 3. We can use the bullet style 
option to apply bullet in the text. 4. For changing the text 
style and size, select the text and click on Bold, Italic and 
Underline options on the Formatting toolbar. 5. To change 
the text size firstly we select the text  click on the box of 
the Font size tool and select the size of font. 

CHAPTER 6 : INTRODUCTION TO MS WORKD 2016

A. 1. b 2. a 3. b 4. a 5. b B. 1. MS Word 2. Text area 3. 
Status bar 4. Rullers 5. Tital bar C. 1. F 2. T 3. F 4. F 5. T 
D. 1. MS Word 2016 is the Word Processing software. It is 
used to typing text on the computer. 2. (i) We can connect 
to a Microsoft e-mail account and send mails directly. (ii) 
We can change the size and style of letters and make them 
colourful. 3. To open a new document we click on File tab 
and select New option and select Blank document. 4. (i) 
Title Bar : IT appears on the top of the screen. Tital bar 
displays the name of the current document and current 
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program. (ii) Quick Access Toolbar : It is present on the 
Title bar. It helps us to do common tasks with just one click. 
5. To save a document, we click on File tab and select Save 
option and type the File name in the file name box and click 
on Save option.

CHAPTER 7 : MORE ON PAINT 

A. 1. c 2. b 3. a B. 1. cut 2. Ctrl+S 3. Ctrl+O 4. Copy 5. 
Curve C. 1. F 2. F 3. T 4. T D. 1. Various selection tools in 
MS Paint are. (i) Rectangular Selection tool. (ii) Free-Form 
selection tool. 2. (i) We use the Paint Program to create, edit 
and print the pictures. (ii) We can use the Paint Program, 
to draw various geometrical shapes, cartoons, maps, etc. 3. 
Curved shaped is used to draw smooth and curved lines. 
4. Color picker tool is a very useful tool to copy a colour 
from an existing object and filling it into any other object. 
5. 1. To cut a selected portion of an image, follow the given 
steps: Step (i): Select the portion of the image that you want 
to cut. Step (ii): On the home tab, click cut command in 
the clipboard group. The selected portion of an image is 
cut, that is removed from the image and can be inseted 
anywhere. Step (iii): The cut portion of an image is not 
deleted, it is stored in temporary place called clipboard. 2.  
To  use the  paste command follow the given steps : Step (i): 
Click on the paste command. Step (ii): The object that you 
have cut will reappear on the top left corner of the drawing 
area. Step (iii): place the mouse painter on it and drag it to 
the desired location and release the mouse button. 6. It is 
used to select a rectangle shape area.       
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CHAPTER 8 : LOG ON TO LOGO

A. 1. a 2. c 3. c 4. c B. 1. easiest 2. graphics 3. Recall list 
box 4. Primitives 5. FD C. 1. T 2. F 3. T 4. F D. 1. LOGO 
screen is split into two parts: 1. Main Screen. 2. Commander 
Window. 2. (i) The Main Screen: Main Screen shows the 
result of the Czommands. It is also called graphics screen.  
(ii) The Commander Window: This is the window which 
we use to give commands to LOGO. 3. • The turtle is a 
small triangular structure that obeys only LOG commands. 
It has two parts. The pointed top of the turtle is known as 
the head and the bottom part of it is known as the tail. 4. 
HOME command is used to get the turtle to the centre of 
the screen. 5. The LEFT or the LT primitive is used to turn 
the turtle towards the left side.

ASSESSMENT TEST PAPER–1 

A. 1. a 2. a 3. a 4. c 5. b 6. b 7. a 8. a 9. b 10. c B. 1. DVD 
ROM 2. Start 3. Software 4. Alphabet 5. Operating System 
6. Icon C. 1. Software the controls the overall working of a 
computer is called a system software. 2. Operating system 
is a part of computer that makes a computer run. 3. Plotter 
is a part of computer that is used to taken large printouts. 
4. Yes 5. Hardware are the parts of computer which can be 
seen or toched, while software cannot be seen or toched. 
E. 1. The ALU perfoms all the Arithmatic Calculations and 
Logical Comparisons. Control Unit controls the movement of 
information between the registers, ALU and other parts of 
computer. Registers are the small memory units in the CPU, 
where all the data to be processed and stored. 2. To shutting 
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down the computer click on, start button  Click on Shut 
down option in apeared menu. 3. Hardware : Keyboard, 
UPS, monitor. Software : Windows, WordPad, MS Word 

4. Different types of keys on the keyboard are, alphabet 
keys, number keys, function keys, spacebar key, enter key, 
arrow keys, del. key, back space key, shift key, caps lock key, 
etc. 5. To operate a computer we need an operating system 
because with out operating system a computer is useless.

6. Features of MS Windows 10 are as follows : (i) Windows 
10 is more attractive with a complete set of new themes and 
icons. (ii) Windows 8 is include in it. (iii) It has an improved 
search tool-cortana, which helps us to find information on 
the system or on the Web directly.

ASSESSMENT TEST PAPER- II 

A. 1. c 2. b 3. a 4. c 5. a 6. c B. 1. Format 2. File 3. MS-
Word 4. Title bar 5. Copy 6. Easiest C. 1. F. 2. F. 3. F. 4. F. 5. 
F D. 1. To save the file in WordPad click on File menu  
click on Save option. 2. Four features of MS Word 2016 are 
as follows : (i) We can change the size and style of letters 
and make them colourful. (ii) We can cut, copy and paste 
text anywhere in the file. (iii) We can insert the picture 
in the document. (iv) We can edit words and sentences. 
3. Curve shape in MS Paint is used to draw smooth and 
curved lines. 4. Two features of MS-Paint are : (i) We use 
the Paint program to create, edit and print the pictures. (ii) 
We can draw Various geometrical shapes, cartoons, maps, 
etc. in MS-Paint. 5. LOGO is one of the easiest language of 
computer. Its full form is Logic Oriented Graphic Oriented. 
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We use LOGO for drawing pictures, doing calculations and 
printing text. 6. The main screen and commander window 
are the main parts of LOGO Screen.   

  
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TECH WORLD-4
CHAPTER 1 : INPUT PROCESSING AND OUTPUT 

DEVICES OF THE COMPUTER

1. b 2. b 3. c 4. a B. 1. CPU 2. Control 3. Output 4. Joystick 5. 
Storage device C. 1. F 2. T 3. T 4. F 5. T D. 1. A printer is an 
output device which is used to take output on a paper. The 
most commonly used printers are (a) Dot Matrix (b) Inkjet, (c) 
Laser printers. 2. Output devices show the result of the work 
done by the computer. Two output device are (i) Monitor 
(ii) Printer. 3. It is the main memory of the computer. It is 
presented on the motherboard. It is of two types RAM and 
ROM. 4. The CPU has mainly three parts. (i) MU (Memory 
Unit): (ii) ALU (Airthmetic and Logical Unit): (iii) CU (Control 
Unit): 5. The secondary memory is used to store the data 
permanently. 6. Digital camera is used to take photographs 
and record Videos and light pen is used to select objects 
on the screen.

CHAPTER 2 : MANAGING FILES AND FOLDERS

A. 1. a 2. b 3. a B. 1. desktop 2. cortana 3. all apps 4. File 
explore C. 1. F 2. T 3. F 4. T D. 1. (i) Window 10 has a very 
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attractive transparent look with blue highlighting features. 
(ii) Window 10 has a refined and powerful tool cortana. It 
allows us to search for information on the system or on the 
Web directly. 2. A file is a collection of related information 
and a folder is a cllection of files. 3. The PC icon is used 
to access and manage all the foloders and files that are 
stored in the computer. 4. Cortana is a powerful searching 
tool of windows 10 that allows us to search for information 
on the system or on the Web directly. 5. The Start Menu of 
Windows 10 gives us quick access to apps and services.

CHAPTER 3 : WORKING WITH WINDOW 10

A. 1. c 2. c 3. b 4. b B. 1. Windows 10 2. Cascading  
3. tasks 4. Windows 10 5. deleting C. 1. F 2. F 3. F 4. T 5. T   
D. 1. (i) Searching Made Easier We can search any file 
or folder quickly in our computer. (ii) Window Supports 
Multitasking Window 10 can perform effectively many task 
at a time. 2. File: A file is a collection of data stored on some 
storage device. Folder: A folder is a place where many files 
are stored. 3. To create a new folder on desktop. Right click 
the mouse button anywhere on desktop and choose New 
option from the pop up menu. 4. To delete a file or a folder, 
follow any of these steps. (i) Select the file or the folder, press 
the Delete key (ii) Right-Click the file or the folder and then 
click the Delete option from the shortcut menu that appears.  
3. The confirm Delete File/ Folder dialog box appears. 5. Ctrl 
+ C and Ctrl + U are the short cut commands that are used 
to copy a file or folder to another drive. 
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CHAPTER 4 : INTRODUCTION TO  MULTIMEDIA 

A. 1. a 2. c 3. a B. 1. sound card  2. Microphone  3. Multimedia   
4. autorun  C. 1. F 2. T 3. T D. 1. Multimedia is a collection of 
text, graphic, sound, animation and video clips. 2. Its solves, 
sums, prepares bills, plays game and movies, helps us to 
listen songs and do a lot of work for us and our family. 3. To 
install a multimedia CD, follow the given steps: (i) Insert the 
CD in the CD ROM drive. (ii) Open 'COMPUTER' icon desktop 
by double clicking on it. (iii) Double-click the CD icon. The 
CD opens and its contents gets visible. (iv) Now, double-
click the setup icon in the CD contents. (v) Complete the 
installation of software by following the instructions. Yours 
software installation is complete and now you may use it.     

           CHAPTER 5 : MS WORD 2016

A. 1. c 2. b 3. a 4. b B. 1. Word Processing 2. document 
area 3. Quick Access 4. Editing 5. Copy 6. Ctrl+c, Ctrl+V, 
7 Redo Undo 8. Formatting C. 1. F 2. F 3. T 4. F 5. T D. 1. 
Microsoft word is a word processing software. It allows us 
to type the text on a computer. 2. Making changes in a 
document is called editing. 3. Changing and arranging text 
in a document to make it attractive is called formatting. 4. 
(i) Directly connect to a microsoft email account. (ii) Change 
the size and style of letters and make them colourful. (iii) We 
can insert a picture in the document. 5. Moving means to 
shift the text from one place to another and copying means 
nothing but to copy text, word or sentence. 6. To sign into 
the office 2016, click on Sign in. Type your email address 
of the account that you would like to use with office. Type 



20 Teacher's Manual

password and click on Sign in tab. 6. To make text Bold, Italic 
and Underline : Select the text  click on Home tab  
click oon B for bold, I for italic or U for underline. 

CHAPTER 6 :  MORE ABOUT MS POWERPOINT 2016

A. 1. b 2. c 3. c 4. c B. 1. F5 2. .PPT 3. Slides 4. slide 5. 
Notes pane C. 1. F 2. T 3. T 4. T 5. F D. 1. MS PowerPoint is 
a presentation graphic software developed by microsoft. 2. 
(i) Click on the File tab New option. The Available Templates 
and Themes pane appears. (ii) Choose the Blank presentation 
option. Click on Create button or simply double- click the 
Blank presentaion option. (iii) A new  presentation  with 
a blank slide will open in the PowerPoint screen. 3. A 
presentation is a structured set of slides where as a slides 
is single page in the presentation. 4. A presentation is a 
structures delivery of information. It is a systematic display 
of information along with graphics, movies and sounds. 5. 
Slides Tab: The Slide tab shows thumbnails of all slides in 
the presentation. This tab allows the user to move slides 
easily from one position to the other. Outline Tab: The 
outline tab displays the text content of each slide. We can 
edit our text directly in the outline view. Notes Pane: In 
the notes pane, we can type our personal notes about the 
current slide.  

CHAPTER 7 : LOG ON TO LOGO 

A. 1. b 2. b 3. a 4. b 5. a B. 1. Pause 2. Status Button  
3. Sum 4. Print 5. only one C. 1. F 2. T 3. F 4. T 5. T D. 1. 
LOGO is a simple programing language used for drawing 
basic shapes and performing arithmetic calculations. 2. 
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The term Looping means performig the same work again 
until the desired output is obtained. In LOGO, we use the 
REPEAT primitive for looping. The REPEAT primitive saves a 
lot of time as the command for looping. This is the syntax 
of the REPEAT primitive. For example, to print 'LEARNING 
LOGO IS FUN' three times, we need to give PR [LEARNING 
LOGO IS FUN] command 3 times. Alternatively, we can use 
the REPEAT command. REPEAT 3 [LEARNING LOGO IS FUN].   
3. Print is a very important primitive to display a letter, a 
number, a word or a sentence in the commander windows  
the print command can also be used for doing calculations.   
It can take only one input at a time. 4. • After typing Print 
command, leave one space and then type the numbers with 
the desired operator(s). • All the arithmetic operators take 
two inputs. 

CHAPTER 8 : MORE ON INTERNET 

A. 1. a 2. b 3. b 4. a B. E-mail 2. Internet Service Provider 
3. Copy 4. MAN 5. e-greetings C. 1. T 2. T 3. F 4. F D. 
1. Internet is an easy way to get information from all over 
world. It provides numbers facilities to people. It helps us to 
access information, get the latest updates, send and receive 
messages, download songs and movies, send greeting 
cards, chatting, do Online shopping, etc. 2. E-mail is a way 
of sending and receiving mails through the Internet. 3. The 
main components of e-mail are-Inbox, compose, send Reply, 
forward and Delete. 4. LAN (Local Area Network) : In this 
network, computers lying within a room building or in a few 
neighbourhood buildings are connected to each other. MAN 
(Metroplitan Area Network) : This network spreads over 
an entire metropolitan area (city) connecting computer of an 
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organisation placed at different locations. WAN (Wide Area 
Network) : This network can spread over an entire country. 
Continent or can even spread over the entire world.

ASSESSMENT TEST PAPER-1

A. 1. a 2. c 3. b 4. a 5. a 6. b 7. a 8. a 9. c 10. b B. 1. machine 
2. Input, insptructions 3. touchpad 4. operating 5. Windows 
10 6. Edge 7. Rename 8. Copy, Paste 9. multimedia 10. sound 
C. 1. There are 104 keys an the keyboard. 2. Touchpad is a 
sensitive pad used in laptop instead of mouse. 3. We use a 
lightpen to select the objects on the screen. 4. CPU 5. Devices 
that show the result of the word are called output devices. 
6. RAM stands for Random Access Memory and ROM stands 
for Read Only Memory. 7. Pen drive is a small portable 
storage device 8. Windows 10. 9. Edge is the default browser 
of windows. 10. A shortcut is an icon which provides an easy 
and quick method to open any application or software. D. 
1. Devices that are used to enter data and information into 
the computer are called Input devices and the devices that 
show the result of work of the computer are called output 
deivces. 2. CU (Control Unit), ALU (Arithmatic and Logic 
Unit), and Registers are the three parts of processind device. 
3. (i) Windows 10 has a very attractive transparent look with 
blue highlighting features. (ii) Windows 10 given us quick 
access to apps and services. (iii) Windows 10 has a refined 
and powerful search tool cortana. It allows us for searching 
information on the system or on the Web directly. (iv) The 
new ‘Taskview’ button on the taskbar providers the ability 
to open multiple desktops at the same time (v) Window 
Snapping feature assits us to work with multiple applications 
on the same screen. 4. File Explorer is an application that 
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provides detailed information about files folders, and drives. 
5. To open a new folder, simple right click in blank space on 
desk top and choose new option from the pop up menu. 6. 
To install a multimedia CD in computer; insert CD in the CD 
ROM drive  Open Computer icon  Double click the 
CD icon  Now double click on Set-up icon.  

ASSESSMENT TEST PAPER-II 

A. 1. b 2. b 3. b 4. c 5. a 6. c 7. b 8. c 9. c 10. b B. 1. 
editing 2. Formatting 3. Graphic 4. Slide 5. Programing 
6. two 7. Internet 8. E-mail C. 1. MS Word 2016 2. Tabs, 
groups and commands are the parts of Ribbon. 3. Ctrl+C. 
4. A presentation is a structured delivery of information. 
5. A slide show is an electronic presentation displayed on 
computer screen. 6. In PowerPoint the Title bar is located 
at the top of the PowerPoint Window. 7. Placeholder is a 
dotted rectangular box. 8. Logic Oriented Graphic Oriented. 
9. Main screen and Commander Window. 10. Network is a 
group of computers, which are connected to each other. D. 
1. The main features of MS Word 2016 areas follows : (i) 
Directly connect to a microsoft e-mail account. (ii) Change 
the size and style of letters and make them colour full. 
(iii) We can cut, copy and paste text. (iv) We can insert a 
picture into the text. (v) We can edit words and sentences. 
(vi) We can check and correct spillings and grammar. 2. 
To sign into the office 2016, click on sign in. Type email 
address of the account and type password and click on 
sign in tab. 3. A presentation consists of a number of slides 
and a slide is in an electronic presentation. 4. LOGO is a 
simple programming language that is used for drawing 
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basic shapes and performing with mathmatic calculations. 
5.  Print is a very important primitive to display a letter, 
number word and a sentence in the commander window. 
It can alsobe used for doing calculations. 6. Internet is an 
easy way to get information from all over the world. It is 
very helpful to access information, get the latest updates, 
send and receive messages, download songs, moves, send 
greeting cards, chatting, do online shopping with different 
people and many others.

  

Teacher's Manual
TECH WORLD-5

CHAPTER 1 : CHARACTERISTIC AND 
EVALUTION OF COMPUTERS

A. 1. b 2. b 3. a 4. c B. 1. Difference Engine 2. Charles Babbage 
3. Vaccum tubes 4. EDSAC C. 1. T 2. T 3. F 4. T D. 1. Abacus 
was the first calculating device that was used to perform 
simple calculation like, addition subtraction, multiplication 
and division. 2. Limitations of First generation of computers 
: (i) Operating speed was quite slow. (ii) Power consumption 
was very high. (iii) Required large space for installation. (iv) 
Patential to be programmed for tasks was quite limited. 3. 
The Artificial Intelligence is a branch of science that aims 
to create computers that can think, behave and react the 
same way as humans do. 4. The main features of fourth 
generation of computers are : (i) Use micro-processor, which 
contain all the components of a ACPU in a single chip. (ii) 
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Greater computing power and storage capacity than the 
earlier generation of computer. (iii) Improved storage devices 
that are cheaper than the earlier ones. (iv) They can linked 
together to share storage capacity, space, data. 5. The laptop 
is small in size and can be placed on the lap and the tablet 
computer is smaller and lighter than lap top but bigger 
tham smart phones.  

CHAPTER 2 : COMPUTER LANGUAGES

A. 1. b 2. b 3. a 4. a 5. c B. 1. Computer, human being 2. 0 
and 1, 3. machine-oriented language 4. High level languages 
5. Compiler and Interpreter C. 1. F 2. F 3. T 4. T 5. T D. 1. 
Low Level Language 2. Assembly Language 3. High Level 
Language 4. Formula Translation 5. Biginners All Purpose 
Symbolic Instruct Code 6. Assembly Language 7. Machine 
Language E. 1. A computer language is the means by which 
instructions and data are transmitted to the computer. 2. Low-
Level language is machine-oriented language. It is simple 
but consedered difficult to use, While High Level Language 
is a programming language that enables a programmes to 
write programms that are machine independent. 3. Assambly 
Language have the same structure and set of commands as 
machine language but it enables a programmes to use names 
instead of number (0 and 1). But High Level Languages are 
programming languaes and a Computer Understands the 
High Level Language. 4. Categories of High Level Languges :

(i) Algebraic Formula : BASIC, FORTRAN, AIGOL, APL 
(ii) Busness Data Processing : COBOL, RPG
(iii) String and List Processing : LISP, Prolog.
(iv) Object Oriented PROGRAMMING : C++, JAVA
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(v) Visual Programming Language : Visual BASIC, Visual 
JAVA, Visual C.

5. Advantages of High Level Language : (i) User-friendly. 
(ii) Easy to learn. (iii) Require less time  to write. (iv) Easier to 
maintain. (v) Problems Oriented rather than machine based. 
(vi) It is independent of the machine on which it is used 
programs developed in High Level Languages can be run 
on any computer. 

Disadvantages of High Level Language 

(i) It need translator translate into Machine Language. 

(ii) The object code generated by a translater might be 
inefficient as compared to an equirilent Assembly Language 
Program.

6. Assembler is a program that is used to convert Assembly 
language to machine language. 7. Compiler is a software 
that translates a HLL program into Machine Language at 
once and Interprater is also translates HLL into Machine 
Language. It translates one line at the time of program.

CHAPTER 3 : UNDER STANDING WINDOWS 10

A. 1. a 2. a 3. a 4. c 5. b B. 1. Operating System 2. Personalize, 
3. Photos 4. Icons C. 1. F 2. T 3. T 4. F 5. F 6. T D. 1. Features 
of windows 10– (i) Easy to use, more attractive and the most 
secured. (ii) Much more personal and provides us the ability 
to redecorate our desktop. (iii) The enhanced searchtool. 
Cortana, enables us to search anything on our computer 
or the Web directly. (iv) The application Windows Store 
provides us a bundle of updates apps. 2. Taskbar displays 
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the Start Button on the extreme left side. Search button to 
the next of Start button. To the right of the Search box is the 
Task View Button. Taskbar holds the Notification Area on the 
right side. 3. Universal apps is an integral part of windows 
10 store. as the name suggest, these are apps the work on 
all device sizes from phones to high-powered desktop PCs. 
4. The Start Menu in windows 10 is a blend of old menu, 
found in window 7 and start Screen in Window. 8. When we 
click on the start button at the bottom left of the screen, 
we get two pannels side by side. The left column displays 
the pinned, recently added and most used apps. The right 
column displays a section of live tiles that we can customize, 
resize and reorganize. 5. Desktop is the first screen appeared 
on the monitor after starting the computer. 

6. Steps ot create a group of tiles : 

Step 1 : Drag a tile to the bottom of the right pane in 
the start menu. A transparent horizontal bar appears with 
heading Name Group on the left side and two small 
horizontal lines of the right.

Step 2 : Click on Name group and add a name. Now you 
can add the relevant tiles in this group.

Step 3 : To move a whole group of tiles, drag the two small 
lines to the desired position.

7. To display mutiple windows at a time, follow the given 
steps : 

Step 1 : First open Word 2016 and PowerPoint 2016.

Step 2 : Now right-click anywhere on the blank portion of 
the taskbar.
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Step 3 : Click on the Show Windows side-by-side option 
from the Shortcut menu Both the application windows will 
be displayed side-by-side.

CHAPTER 4 : MORE ON MICROSOFT WORD 2016 

A. 1. b 2. a 3. a 4. c B. 1. Symbols, special characters 2. 
WordArt 3. Shape file, Shadow effect 4. Insert C. 1. F 2. F 3. T 
4. F D. 1. Features of MS Word 2016 : • It provides features 
to type and modify text. • It also enhances the appearance 
of text and gives an option to preview a document before 
printing it. • It allows you to insert graphics in your document 
and make use of various drawing tools to draw pictures. • 
It allows you to copy and move text from one location to 
another. • It offers you to produce letters, reports, notices, 
news letters, books, bills etc., quickly in a presentable 
manner. 2. The Microsoft Word 2016 is quite similar to 
Word 2010 with some additional features. The Ribbon has 
three parts: Tabs, groups and Commands. each group has an 
organized set of related commands. For example, the Home 
tab contains commonly used commands for writing and 
formatting documents such as font formatting commands 
(Font group), paragraph options (Paragraph group), and 
styles (Styles group). 3. ClipArt are the readymade pictures. 
4. Shapes are the drawing features that helps us to draw 
different shapes like stars, banners, flowchart, lines, callouts 
etc. 5. To insert a WordArt, follow the steps given below: 

Step 1 : Click the Insert tab. Select the WordArt button in 
the Text group. Select a WordArt style. The Edit WordArt 
Text box appears with a selected placeholder text.
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Step 2 : To type the text of format, use the Font options. 
Change the formatting effects like font font sixe, bold and 
italic. Click on OK. You will find a beautiful change in the 
text. 

6. To insert Header, follow the steps given below :

Step 1 : Click the Insert Tab. 

Step 2 : Click Header from Header & Footer group. A gallery 
appears. 

Step 3 : Choose the style of your choice.

Step 4 : Now, type the text you want at the top of each 
page.

Step 5 : Now, click Close Header and Footer from Close 
group in the Design tab.

To insert Footer, follow the steps given below :

Step 1 : Click the Insert tab.

Step 2 : Click Footer group. A gallery apears.

Step 3 : Choose the style of your choice.

Step 4 : Now, write the text for the footer and lick close 
Header and Footer from Close group in the Design tab.

CHAPTER 5 : TABLES IN MS WORD 2016

A. 1. b 2. c 3. a 4. b B. 1. Column 2. Layout 3. Table Styles 
4. Data 5. Table serize C. 1. c 2. d 3. b 4. a D. 1. F 2. F 3. F 
4. T 5. F 6. F E. 1. The vertical data is called a column. 2. To 
divide a cell into many cells, use the Split Cells option.

Step 1 : Select the cell which you want to split.
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Step 2 : Click the Layout tab

Step 3 : Click on Split Cells button in the Merge group.

Step 4 : The Split Cells dialog box appears.

Step 5 : Enter the number of rows and columns which you 
want to split the selected cells. Click on Ok. 

3. To write simple expressions, follow the given steps :

Step 1 : Click the Layout tab.

Step 2 : Click in the required cell to get the result.

Step 3 : Click Formula from Data group. The Formula dialog 
box is displayed.

Step 4 : Write the mathematical expression in the Formula 
box. For example, 35+40.

Step 5 : Select the number format in which you want to 
display the result and click Ok button. In this case the result 
75 will be displayed.

4. It is Table styles are used to change the look, colour and 
design of a table.

Step 1 : Click on the Table.

Step 2 : Select the Design tab.

Step 3 : Click More button from Tables Style group. Choose 
any visual style form the gallery.

The preview of the selected style can be seen on the table. 
Click OK to apply.
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5. to divide a cell into many cells is called split cells and 
combining two or more cells in the same row and column 
into a single cells is called merging.

CHAPTER 6 : INTRODUCTION TO MS EXCEL 2016

A. 1. b 2. c 3. a 4. c B. 1. Status bar 2. Cell 3. formula 4. 
Formula C. 1. T 2. F 3. T 4. F D. 1. Spreadsheet is a system 
of recording numerical data consisting of a grid (or table) of 
rows, columns and cells, where data is entered. 2. MS Excel 
is the most popular software the helps you to : 1. Arrange 
data in an organized way. 2. Type less and get more. 3. 
Perform calculations. 4. Auto recalculation. 5. Auto format 
table. 6. Compare data through chart. 

3. Components of Excel 2016

Title bar : It appears on the top of the screen. The title 
bar displays the name of the current document and current 
program. It also contains Minimize, Maximize and Close 
buttons.

Quick Access Toolbar : It is present on the title bar. It helps 
you to do common tasks with just one click. 

Ribbon : The Ribbon has three parts : Tabs, Groups and 
Commands. Each group has an organized set of related 
commands. 

File Tab : It contains different options to work in MS Excel 
2016.

Formula Bar : The formula bar is made up of two parts : 
Name box and Formula box.
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Sheet Tab : The worksheet names appear on the sheet tab. 
The name of the active sheet is displayed in bold letters. You 
can move from one sheet to another by clicking at its tab.

Status Bar :  This displays current status of the cells and 
Zoom option.

Range : A range is a group of contiguous cells, which form 
the shape of a rectangle. It can be as small as a single cell 
or as big as an entire worksheet. You can specify a range by 
writing the starting cell address followed by the ending cell 
address, both separated by a colon (:) for example, C1 : C10 
indicates a range starting from C1 cell address and ending 
in C10 cell address.

Name Box : Name box is located just above the column 
heading on the left side of Window. This area displays the 
location of the cell pointer.

Column Heading : Alphabets across the top border of 
each worksheet are called column heading. These headings 
identify columns with letters A to Z, AA........ AZ.........., 
BA............., BZ........ XAA..............XFD. Each worksheet in Excel 
contains 16,384 columns.

Worksheet : An Excel document is called a workbook. The 
blank worksheet is a part of the workbook.

4. A cell is the space which is formed by the intersection 
of one row and one column. Each small rectangle in a 
spreadsheet is called a cell. 

5. It is easy to save your Excel files in one drive.

Step 1 : Click on File Tab. 
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Step 2 : Select the Save option or Save As. The file will be 
saved.    OR

Press Ctrl + S

OR

Click on Save icon on the Quick Access Toolbar.  

CHAPTER 7 : MORE ON MS POWERPOINT 2016 

A. 1. b 2. c 3. a 4. b B. 1. Presentation 2. Slide 3. .ppt 4. Normal 
C. 1. T 2. F 3. F 4. F D. 1. Ms PowerPoint is a presentation 
software. It is a part of Microsoft Office package. It creates 
and edits presentation for slide shows, meeting and web 
pages. 2. Installed Themes are the set of pre-designed format 
of text, colour schemes and graphics effect. 3. Slide Sorter 
View Button Shows all the slides of a presentation in one 
screen in the form of small thumbnail image. Slide Show 
View Button is used to run the slide show and see slides 
one screenful at a time. 4. Place holders (dotted rectangular 
boxes) are used to add text, tables, charts etc. on the slide.

CHAPTER 8 : INTERNET AND E-MAIL 

A. 1. c 2. ???? 3. b 4. b 5. a B. 1. information 2. International 
Network 3. Google 4. Blind Carbon Copy 5. ?????? C. 
1. T 2. F 3. T 4. F 5. T D. 1. Internet is one of the best 
technologies gifted to mankind. It has brought the entire 
world closer. Internet stands for 'International Network'. It 
is the largest computer network in the world, connecting 
millions of computers. 2. A Search Engine is a software that 
searches various web pages on the World Wide Web for a 
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particular information. It requires a user to enter a keyword 
related to the information to be searched and displays the 
search results as a list of links to the pages on which the 
keywords are found. 3. E-mail stands for Electronic Mail. It 
is a facility on the Internet to send and receive messages 
anywhere around the world, in real time. 4. CC : In this 
field, one can specify the addresses of the persons to 
whom one wants to send a copy of the mail. 5. Dial up 
Connection : Dial-up connection requires users to link their 
phone line to a computer, in order to access the internet. 
This particular type of connection does not allow user to 
make or receive phone calls through their home phone 
service while using the internet. Broadband Connection : 
As the term suggests, this connection uses wide bandwidth, 
which provides high-speed internet access through various 
transmission mediums. It is significantly faster than a dial-
up connection. Using broadband, you can share videos, 
download music, programms, or photos within no time. 
Unlike a dial-up connection, a broadband connection does 
not disrupt your phone line, so you are free to make and 
receive while online. 6. (i) We transfer : We transfer is a free 
online file transfer service that enables you to send files up 
to 2 GB from one system to another. (ii) Sendspace : It is 
another file transfer service that help you to share large files 
of upto 300 MB, free of cost. 7. Modem : MODEM stands 
for Modulator DEMoudlator. It is a device which allows a 
computer to send or receive information through telephone 
lines by converting digital data into an analog signal, used 
on telephone lines. Types of Modem– Internet Modem : is 
a device that is already installed in the computer. It is in the 
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form of a card that is inserted into one of the slot on the 
main board. External Modem : is a modem that is installed 
outside the CPU. It is in the form of a box that is normally 
connected to USB port of a computer. This type of modem 
has indicator lights that display the status of modem. The 
speed of a modem is measured in bps and kbps (kilo bits 
per second). Although a modem can have a maximum speed 
of 56 kbps but if the telephone line quality is not good, it 
will not be able to work with its maximum speed.

PC Card Modem is specifically designed for laptops and 
handheld computers. It is similar to the size of a credit card 
and fits into the PC Card slot on notebook and handheld 
computers. So no cable is required other than the telephone 
line connection. One can remove this modem when it is 
not needed. Except for its size, PC Card modem is like the 
combination of external and internal modems. This card is 
powered by a computer. 

ASSESSMENT TEST PAPER - I 

A. 1. b 2. b 3. b 4. a 5. b 6. a 7. b 8. a 9. c 10. c B. 1. Vaccum 
tube 2. EDSAC 3. machine-oriented language 4. 0 and 1 5. 
Operating System 6. Photos 7. Symbols, Special characters 
8. Insert C. 1. ENIAC : Electronic Numerical Integrator and 
Computer 2. EDVAC : Electronic Discrete Variable Automatic 
Compter 3. UNIVAC : Universal Automatic Computer 4. IC : 
Integrated Circut 5. LLL : Low Level Language 6. HLL : High 
Leval Language 7. GL : Generation of Language 8. ASL : 
Assembly Language 9. ML : Machine Language D. 1. The 
following are the characteristics of the fourth generation of 
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computers, i.e., the present-day computers : They use micro-
processors, a type of Very Large Scale Integrated Circuits 
(VLSIC), which contain all the components of a CPU on a 
single chip. The VLSICs perform the bulk of processing and 
control all parts of a system. The use of micro-processors 
resulted in decreased size and increased efficiency. They 
have much greater computing power and storage capacity 
than the earlier-generation of computers. They use improved 
storage devices that are cheaper than the earlier ones. They 
can be linked together (i.e., networked) to share storage 
capacity, space, data, etc. 

2. Computer Language

Low Level Language

Machine 

Language

Third 

Generation

Language

(3GL)

Fourth 

Generation

Language

(4GL)

Natural

Language

Assembly

Language

High Level Language

`
  

3. Assembler is used to convert Assembly Language to 
Machine Language. 4. Universal apps is an integral part of 
the Windows 10 store. As the name suggests, these are apps 
the work on all device sizes from phones to high-powered 
desktop PCs. 5. The most striking features of Window 10 are 
as follows : It is easy to use, more interactive and the most 
secured version of Windows. • It is much more personal and 
provides you with the ability to redecorate your desktop with 
new backgrounds, themes, colours and icons. • The enhanced 
search tool, Cortana, enables you to search anything on your 
system or the web directly. It lets you play music, videos 
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write notes, set alarms and reminders, perform calculations, 
send e-mails, change wallpapers and a lot more, through 
voice commands. • The application Windows Store provides 
a bundle of updated apps including Videos, Music Movies, 
Photos, Maps, Messaging, Mail, Calendar etc. • Windows 10 
enables you to manages your desktop and windows in a 
better way. • You can create multiple desktops for different 
set of applications by using the Task View button. 6. To insert 
a WordArt, follow the steps given below : Step 1 :  Click the 
Insert tab. Select the WordArt button  in the Text group. Select 
a WordArt style. The Edit WordArt Text box appears with a  
selected placeholder text. Step 2 : To type the 
text of format, use the Font options. Change the  
formatting effects like font, font size, bold and italic. Click on 
OK. You will find a beautiful change in the text. 

ASSESSMENT TEST PAPER-II

A. 1. b 2. a 3. b 4. c 5. b 6. b 7. c 8. b B. 1. tabular 2. merging 
3. spreedsheet 4. cell 5. presentation 6. slide 7. International 
Network 8. Blank Carbon Copy C. 1. Spreadsheet is a 
system of recording numerical data consisting of a grid (or 
table) of rows, columns and cells, where data is entered. 2. 
The horizontal data is called a row. 3. The Individual each 
rectangle is called a cell. 4. Combining two or more cells in 
the same row or column into a single cell is called merging. 
5. E-mail stands for Electronic Mail. It is a facility on the 
Internet to send and receive messages anywhere around the 
world, in real time. D. 1. Personal Computer 2. Minimum 
3. Maximum 4. Modulator Demodulator 5. Carbon Copy 6. 
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Blank Carbon Copy E. 1. Table styles are used to change 
the look, colour and design of a table. Step 1 : Click on the 
Table. Step 2 : Select the Design tab. Step 3 : Click More 
button  from Tables Style group. Choose any visual style 
from the gallery.

The preview of the selected style can be seen on the table. 
Click OK to apply. 2. MS Excel is the most popular software 
that helps you to : 1. Arrange data in an organized way. 
2. Type less and get more. 3. Perform calculations. 4. Auto 
recalculation.  5. Auto format table. 6. Compare data through 
chart. 

3. Components of Excel 2016

Title bar : It appears on the top of the screen. The title 
bar displays the name of the current document and current 
program. It also contains Minimize, Maximize and Close 
buttons.

Quick Access Toolbar : It is present on the title bar. It helps 
you to do common tasks with just one click. 

Ribbon : The Ribbon has three parts : Tabs, Groups and 
Commands. Each group has an organized set of related 
commands. 

File Tab : It contains different options to work in MS Excel 
2016.

Formula Bar : The formula bar is made up of two parts : 
Name box and Formula box.

Sheet Tab : The worksheet names appear on the sheet tab. 
The name of the active sheet is displayed in bold letters. You 
can move from one sheet to another by clicking at its tab.
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Status Bar : This displays current status of the cells and 
Zoom option.
Range : A range is a group of contiguous cells, which form 
the shape of a rectangle. It can be as small as a single cell 
or as big as an entire worksheet. You can specify a range by 
writing the starting cell address followed by the ending cell 
address, both separated by a colon (:) for example, C1 : C10 
indicates a range starting from C1 cell address and ending 
in C10 cell address.

Name Box : Name box is located just above the column 
heading on the left side of Window. This area displays the 
location of the cell pointer.

Column Heading : Alphabets across the top border of 
each worksheet are called column heading. These headings 
identify columns with letters A to Z, AA........ AZ.........., 
BA............., BZ........ XAA..............XFD. Each worksheet in Excel 
contains 16,384 columns.

Worksheet : An Excel document is called a workbook. The 
blank worksheet is a part of the workbook. 

4. Ms PowerPoint is a presentation software. It is a part of 
Microsoft office package. It creates and edits presentation 
for slide shows, meeting and web pages. 

5. A Search Engine is a software that searches various web 
pages on the World Wide Web for a particular information. It 
requires a user to enter a keyword related to the information 
to be searched and displays the search results as a list of 
links to the pages on which the keywords are found.
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6. Modem : MODEM stands for Modulator DEMoudlator. 
It is a device which allows a computer to send or receive 
information through telephone lines by converting digital 
data into an analog signal, used on telephone lines. Types 
of Modem– Internet Modem : is a device that is already 
installed in the computer. It is in the form of a card that is 
inserted into one of the slot on the main board. External 
Modem : is a modem that is installed outside the CPU. It 
is in the form of a box that is normally connected to USB 
port of a computer. This type of modem has indicator lights 
that display the status of modem. The speed of a modem is 
measured in bps and kbps (kilo bits per second). Although 
a modem can have a maximum speed of 56 kbps but if the 
telephone line quality is not good, it will not be able to work 
with its maximum speed.

PC Card Modem is specifically designed for laptops and 
handheld computers. It is similar to the size of a credit card 
and fits into the PC Card slot on notebook and handheld 
computers. So no cable is required other than the telephone 
line connection. One can remove this modem when it is 
not needed. Except for its size, PC Card modem is like the 
combination of external and internal modems. This card is 
powered by a computer.

  


